Chapter 5

Purchasing

OVERVIEW PURCHASING

To enter an order in Oracle, the department will create a requisition. As part of entering a requisition, the user will define the order type. These include:

- Purchase Order,
- Standing Order or
- Check Request

Once the requisition is entered, it will be submitted for department approval. The requisition will be routed electronically to the appropriate department approver based upon the predetermined Position Hierarchy. At this time, an on-line funds check should be performed to ensure there are adequate funds to cover this expense.

The approver will be able to access, review, edit, and approve the requisition by using the Notification Summary.

Upon approval, a processing copy will automatically be routed to Purchasing for all Purchase Order and Standing Order types and to Accounts Payable for all Check Request. The requisitions will be reviewed and an “autocreate” process will be performed which will create the actual order. The order will be referred to as a Purchase Order in Oracle; please note however, it will include all the order types - Purchase Orders, Standing Orders, and Check Requests. Once adequate back up is received and policy compliance is verified; the orders will be administratively approved.

At this point:

- For all Purchase Orders and Standing Orders, the “official Purchase Order” will be created and routed to the supplier according to the department’s instructions.
- Check requests will be ready for invoice creation and subsequent payment.

Refer to Glossary section for Definitions.
Although two documents are created, a requisition and an order, they will be identified by the same number.

Users will be able to query both requisitions and orders to review the current status and action history. Information regarding who approved requisitions and orders, when they were approved, and their current status, is always available.

Through Reports, hard copies of both requisitions and orders may be obtained by the end-users at any time during the process.

Encumbrances will be created at the time of requisition approval, order approval and invoice creation.
CREATING NEW REQUISITIONS

Navigation Path: MCW Purchasing End-User Entry > Requisitions > Requisitions

CREATING A BASIC REQUISITION

Overview

To enter an order (Purchase Order, Standing Order, or Check Request), the user will create a requisition. Start by accessing the Requisitions window and completing the sections per the following instructions. There are three parts to the Requisition window, header, line(s), and distribution(s).

- **Header** – includes fields found on the top of the window (H-1) and additional information that is entered using the flexfield (H-2).

  Definition – a flexfield in Oracle is a custom-created entry field. Flexfields allow us to customize the window and get information that would not be provided in Oracle out-of-the-box functionality. In the Requisitions window, a query can be performed on a flexfield.

- **Line** – fields found in the Lines tab (L-1) and at the bottom of the window (L-2).

- **Distribution** (for each line) – access the button at the bottom of the window (D-1).

NOTE: As part of Oracle standard functionality, data is required in all fields with a yellow background. A record cannot be saved unless these fields are complete. Entering data in fields with white background is optional and is not allowed in fields that are gray.
Navigation

1. **Navigation** - to create a requisition, navigate to the **Requisitions** window by selecting **Requisitions > Requisitions** from the MCW Purchasing End-User Entry responsibility.

The **Requisitions** window will appear.

- **Header Section – H-1**
- **Header Flexfield – H-2**
- **Line item Section – L-1**
- **Add'l line information – L-2**
- **Distribution Button – D-1**
Header Information

2. Enter **Header** (H-1) information:

- **Number** field – Oracle automatically assigns a unique requisition number when the work is saved.
- **Type** field – Defaults to **Purchase Requisition**.
- **Preparer** field – Defaults to the preparer’s name.
- **Description** field – This field is used for header comments on Purchase Orders and Standing Orders. The comments entered here will appear in the body of the Purchase Order prior to the items ordered. For a Check Request, this field can be used to provide additional information. This field can be queried to locate a requisition.
- **Status** field – Defaults to **Incomplete** while creating the requisition.
- **Total** field – Oracle automatically accumulates the total dollars for all lines on the requisition.

Header Flexfield Information

3. Enter the **Header flexfield** (H-2) information. Access these fields by choosing the small box as shown below which will cause the **Requisition Headers** window to appear:
• **Buyer Code** field – Enter the department's **Buyer Code** or select the **Buyer Code** from the LOV.

  - The **Buyer Code** is a two- or three-digit alphabetical code that has been established for each department or division. The **Buyer Code** also contains official department designee information. The department designee is the person within each department who will receive all of the purchasing and accounts payable paperwork.

  ![Select the Buyer Code using the LOV.](image)

  - **Buyer Code** field – Enter the department's **Buyer Code** or select the **Buyer Code** from the LOV.

• **Business Associate** – If the supplier being identified in the requisition, by virtue of the services they are performing, has access to patient information, a Business Associate Agreement must be on file. This agreement must be on file prior to placing the order. Select one of the following four choices listed with in the LOV:

  - **BAAA - Business Associate** – agreement is attached as part of the back up for this requisition.
  - **BANA - Business Associate** – the Business Office should obtain an agreement.
  - **BAOL - Business Associate** – agreement is on file.
  - **BANN - Business Associate** - agreement is not needed. If the supplier does not have access to patient information, select this option.

Refer to [HIPAA website for the agreement](http://infoscope.mcw.edu/hipaa/). Select **Business Associate**.
- **STD Trailer Comment** fields – If appropriate, select a standard comment from the LOV. Standard comments are frequently-used short comments. Two fields are available for standard comments.

- **Trailer Comment** fields – If additional, nonstandard, information is needed on the requisition, type the information in the Trailer Comment field(s). Two fields are available for additional comments.

- **Order Type** field – Enter the appropriate order type.
  - **Check Request (CkReq)** – Used to request issuance of a check when a purchase order is not appropriate. Examples include travel reimbursements, dues and subscriptions, honorariums, research stipends, travel registration, etc.
  - **Purchase Order (PO)** – Used for the procurement of all materials, supplies, and services. When PO is selected, two additional mandatory fields will appear.
    - **Original or Confirming** field – Enter the appropriate information to indicate if the order has been placed with the supplier (confirming) or not (original)
    - **Order Placed With** field – If the previous field is populated with Confirming, enter the confirmation number or name of the person with whom the order was placed. If the order is original, leave the field with the defaulted asterisk (*).
  - **Standing Order (SO)** – Used when ordering goods or services repetitively from the same supplier over an established period of time. When SO is selected, three additional mandatory fields will appear.
    - **Standing Order Start Date** field – Enter the date that the order becomes effective
    - **Standing Order End Date** field – Enter the date upon which the order will close
    - **Previous SO # or “New”** field – Enter the previous SO number or, if this a new order for the supplier, enter “New”
– **Doc or No Doc** – Differentiates whether or not documentation is being supplied.

Refer to *Business Policies & Procedures Number 1.02* ([http://infoscope.mcw.edu/business/policies&procedures.htm](http://infoscope.mcw.edu/business/policies&procedures.htm)) for further guidelines as to when to use the above order types as well as when documentation is required.

Select **OK** from the **Requisition Headers** window. The **Requisitions** window will re-appear.
Line Information

4. Enter the Line (L-1) information. From the Lines tab within the Requisitions window, enter the line information as follows:

- **Type** field – Select the LOV, the order type that was chosen at the flexfield level will default. The cursor will automatically move to the next mandatory field.
- **Description** field – Enter a description for each line item. The description should include all detailed information about the item or service being ordered, including the part number, item or service description, and/or other pertinent information. It is important to note that for Purchase Orders, if there is an item or catalog number, that number **MUST BE AT THE BEGINNING** of the description or the supplier may not take the order. When complete, tab to the next field.
- **UOM** field – Select the appropriate unit of measure from the LOV. (If the first few letters of the UOM are typed in the field, be sure to TAB out of the field).

```
NOTE: Use the scroll bar at the bottom of this box to access other line item fields.
```

- **Quantity** field – Enter the quantity of items needed.
  - For a **Purchase Order or Check Request**, enter the number of items being ordered.
  - For a **Standing Order**, enter the total dollars committed to the standing order.

  *Note: the quantity and price values are interchanged for standing orders so that the order can remain open for repetitive purchases.*

- **Price** field – Enter cost of the item.
  - For a **Purchase Order or Check Request**, enter the unit cost of each item.
  - For a **Standing Order**, always enter 1.00, as the quantity and price are reversed.

- **Need-By** field – If a specific delivery date is requested for this line item, enter the date in this field. A date greater than or equal to the requisition creation date must be entered.

All other fields will default appropriately.

```
NOTE: There is no need to access the remaining tabs, Source Details, Details or Currency to complete the requisition.
```
Additional Line Information

5. Complete the **Additional Line Information** (L-2) by completing the bottom portion of the **Requisitions** window.

- **Destination Type** field – Defaults to *Expense*.
- **Requester** field – Defaults to the name of the individual preparing the requisition. This information can be replaced with another name, as applicable, by selecting the name from the LOV. This can be the person for whom the goods or services are being ordered.
- **Organization** field – Place the cursor within this field; *Medical College of Wisconsin* will default.
- **Location** field – Enter the appropriate information dependent upon the type of requisition:
  - For a **Standing Order** or **Purchase Order**, select, from the LOV, the location to where the **goods** are be shipped.
  - For a **Check Request**, select, from the LOV, the location to where the **check** is to be sent. There are two choices when determining where a check will be sent; the department designee or directly to the supplier.
    - If the check should be sent to the supplier, select *Supplier*
    - If the check should be sent to the department, select the appropriate buyer code followed by ***. For example, for the department of Pediatrics, select PD***
- **Source** field – Defaults to *Supplier*. 

![Additional Line Information Example](image_url)
• **Supplier** field – Select the LOV to access the Suppliers window. Find the suggested supplier’s name by using a limited query. If the supplier is not in the list, select ***NEW SUPPLIER***.

• **Site** field – Select the LOV to find and select the appropriate supplier address (site). The site identifiers are alphabetical, usually starting with the letter A. Double click on the appropriate site and the corresponding letter will populate the Site field. If the site is not found within the list, return to the Supplier field and select ***NEW SUPPLIER***.
  - If there is only one site (or address) for the supplier, the associated address detail will appear when LOV is accessed.

Adding a New Supplier or Site – to enter a new supplier or site, select ***NEW SUPPLIER*** from the LOV within the Supplier field. Populate the Site field with "A" and then Save the record.

From the toolbar, select View > Zoom.
The **New Supplier Information** window will appear.

Enter information regarding the new supplier including complete name (include middle initial), address, tax id number, and any other information that may be available.

If the supplier was found within the list of suppliers but the correct site was not, complete the new supplier information as shown above and check the **New Site** box.
• **Contact** field – This field will default to a contact name if a name is associated with a supplier in the system. If a default name does not appear, one may be added however, a first and last name must be provided. When preparing a requisition for a **Confirming Order**, be sure to add, if it is not the defaulted name, the first and last name of the person with whom the order was placed. Remove the name if the requisition is not a Confirming Order.

• **Phone** field – This field will defaults to the supplier phone number if it is in the system. If a default phone number does not appear, one may be added.

**Saving the Record**

6. Select **Save** icon from the toolbar. If all necessary header and line information was entered, the record will be saved and a requisition number will be assigned.

   If any required information is missing, an error message will appear requiring the missing information. Select **OK** and update the record accordingly.

**Entering Distribution**

7. Complete the **Distribution** (D-1) information.

   Access the **Distributions** window by selecting the **Distribution** button from the **Requisitions** window. The **Distributions** window will appear. Hint: it is helpful to reposition the **Distributions** window under the line Item(s) of the **Requisition** window so that both windows can be viewed at the same time.

   There are two tabs found in the **Distribution** window, **Accounts** and **Project**. The **Accounts** tab is used for distribution to General Ledger accounts whereas the **Project** tab is used for distribution to Project (grant) accounts.
Distribution Scenario Summary:

- To distribute **100% to one General Ledger Account**, enter all information for Requisition Line 1 on Distribution Line 1 from the Accounts tab.
- To distribute **100% to one Project Account**, enter all information for Requisition Line 1 on Distribution Line 1 from the Project tab.
- To **split the distribution between one General Ledger Account and one Project Account**, enter the General Ledger account on Distribution Line 1 from the Accounts tab and the Project information on Distribution Line 2 from the Project tab.
- To **split the distribution between multiple General Ledger Accounts**, enter the General Ledger accounts for Requisition Line 1 on Distribution Lines 1, 2, 3, etc. from the Accounts tab.
- To **split the distribution between multiple Project Accounts**, enter the Project accounts for Requisition Line 1 on Distribution Lines 1, 2, 3, etc. from the Project tab.
- To **split the distribution between multiple General Ledger Accounts and multiple Project Accounts**, enter Requisition Line 1 information on the applicable General Ledger and Project distribution lines as needed.

**NOTE:** Be sure that the line quantity and the total of the distribution quantities for that line are equal or the record will not be able to be submitted for approval.
• Enter General Ledger information (select the Accounts tab):
  − **Num** field – Refers to the distribution line number. The field will automatically populate.
  − **Quantity** field – Defaults to the quantity of the requisition line. In multiple distribution scenarios, change the quantity to reflect the appropriate percentage of the quantity that relates to the line of distribution.
    ▪ For example, if 200 files are ordered and 50 percent should be distributed to one account and 50 percent to a second account, the distribution quantity for each of the two distribution lines will be (200 X 50%) or 100.
    ▪ Another example, if a quantity of 1 is ordered and 20 percent should go to one account, 50 percent to a second account, and 30 percent to a third account, the quantity is entered as follows:
      
      Distribution line 001 = quantity .20  
      Distribution line 002 = quantity .50  
      Distribution line 003 = quantity .30

      Refer to **Distributions Quantity Worksheet** (http://infoscope.mcw.edu/oracle/) under **Documents** for calculations.

• **Charge Account** field – Select the LOV to access the Charge Account – Alias window.
  − **Alias** field – Enter the appropriate cost center, or select the LOV and use a limited query to find the available cost centers. Select OK. The Charge Account window will appear with the default fields populated based upon the cost center selected.
Purchasing Requisition Approval

- **Company** field – Defaults to 000100.
- **Cost Center** field – Populates automatically based upon the cost center selected in the **Alias** window.
- **Natural Account** field – Enter the appropriate Natural Account or select one from the **LOV** by using a limited query.
- **Fund** field – Enter the appropriate Fund source or select one from the **LOV** using a limited query.
- **Activity** field – Enter the Activity code or select one from the **LOV**.
- The remaining fields will default based upon the cost center selected.

Select **OK**. The **Distributions** window will re-appear.

For *multiple line* orders, complete the distribution information for Lines 2, 3, etc. as necessary following the same steps as outlined above.

**NOTE:** If a line of distribution is cleared or deleted, remember to save the requisition after using the clear or delete function.
- Enter **Project** information:
  - **Num** field – Refers to the distribution line number. This field will automatically populate.
  - **Project** field – Enter the appropriate Project number.
  - **Task** field – Select the **LOV**. The task will automatically default.
  - **Award** field – Select the **LOV**. The award will automatically default.
  - **Type** field – Enter the appropriate expenditure type or select the **LOV** to view the list of values.
  - **Organization** field – Defaults based on the Project selected.
  - **Expenditure date** field – Defaults to the current date. If this is not within the date of the project, an error message will be displayed. If an error message appears, the actual date that the goods/service was received may be entered. If an error message still appears, contact Sponsored Programs.
  - **Quantity** field – Defaults to the balance of the line quantity.

**Saving Distribution Records**

8. Select the **Save** icon on the toolbar. Close the **Distributions** window.

**Checking Funds**

9. Perform a funds check to ensure that adequate funds are available for this requisition. While the system will automatically perform an official “check funds” at the point of approval, performing a funds check prior to submitting the requisition for approval is encouraged to prevent potential processing delays.

The check funds can be performed line-by-line from the **Distributions** window or it can be done from the **Requisition** window. While in the main **Requisition** window, all lines of the distribution will be checked. Only the selected line of distribution will be checked when the funds check is performed from the **Distributions** window. It is recommended to perform the funds check from the main **Requisition** window first. If a message appears that the action passed with exceptions, the funds check failed or partially failed. If the requisition encompasses multiple lines or multiple lines of distribution, go to the **Distributions** window and perform the check line-by-line to determine where the account problem lies.
• To perform the funds check, select **Tools > Check Funds** from the toolbar. The system will respond with either a pass or fail message.
• If the action completed with warnings, the transaction passed the funds check however it is posted to a project account that is on advisory status. Advisory status indicates that the project is either in pre-award status or has not yet been funded by the grant agency.

![Image 1](null)

• If the action resulted in failed funds, there are several options that may be utilized to resolve the issue:

![Image 2](null)

− Contact the Budget Department and initiate the appropriate changes so that adequate funds are available. Once the re-budget is complete, repeat the check funds process to ensure that adequate funds are now available.
− Change the account number to one in which funds are available. The preparer may still change the distribution at this point because the requisition has not yet been submitted for approval.

**Entering Multiple Lines**

10. If *multiple lines* encompass the order, enter each line separately. To add the next line, use the down arrow key to move the cursor to the next available line. Select Shift + F6 to duplicate the all of the information from the previous line then change the necessary information. Save your record. Enter the distribution for the second requisition line. Continue until all lines are added.

**Submitting the Requisition for Approval**

11. Once the requisition is complete, it may be submitted for approval. See complete details in the subsequent *Requisition Approval* section. To submit the requisition for approval, select the Approve button from the bottom of the *Requisitions* window. The Approve Document window will then appear.
The **Submit for Approval** box will automatically be selected. 
While it is unnecessary in most cases, selecting the **Forward** box will allow the user to view the approval path.
If applicable, a note may be added in the **Note** field. This note will remain a part of the document’s permanent record.
Select **OK**.

*Refer to *Viewing Action History* section to determine workflow.*
CREATING A STANDING ORDER

Overview

Standing orders are used in cases where there are repetitive purchases encompassing a common business purpose from the same supplier over a given period of time. The standing order is usually established at the beginning of the fiscal year (July 1st) or at the beginning of a grant or contract period. The orders typically end at the end of the fiscal year or grant/contract period. An estimate is made in terms of the dollars that will be spent over this period of time and the standing order is set up for that amount.

Standing orders may be created for purchases of goods or services such as:

- Office supplies including printing, coffee, etc.
- Scientific supplies
- Maintenance or lease contracts that are billed monthly
- Utilities, communication services, etc.
- Temporary help

Standing orders would not be appropriate for purchases of goods or services such as:

- Radioactive materials as each order requires secondary approval by Radiation Safety
- Catering, travel or lodging that incorporate more than one business purpose
Creating a Standing Order – Differences from Basic Requisition

When creating a standing order, the instructions provided for entering a basic requisition can be followed with the following exceptions:

1. The Order Type (found on the flexfield header section of the requisition) will be one of the following:
   - SO-Doc - Standing Order with documentation
   - SO-NoDoc - Standing Order without documentation

2. Once the order type is selected, three additional mandatory fields will appear.
   - Standing Order Start Date field – Enter the date for which the order will become effective.
   - Standing Order End Date field – Enter the date upon which the order will close.
   - Previous SO # or “New” field – If this order replaces a previous standing order, enter the previous number. If this is a new order, enter “New”.

![Image of requisition headers with order type, start date, end date, and previous SO number]

![Image of order type selection with SO-Doc and SO-NoDoc options]

![Image of requisition headers with order type, start date, end date, and previous SO number]
3. The **Quantity** and **Price** fields are interchanged so that the order remains open for repetitive purchases. Enter the total dollars committed to the standing order in the **Quantity** field. Enter 1.00 in the **Price** field.

4. Standing Orders should be monitored during the year to ensure that adequate dollars are committed to cover the expenditures. If a Standing Order is completely depleted, the order will be closed. When the amount of a Standing Order needs to be increased or decreased, please notify the Purchasing Department.
CREATING A PURCHASE ORDER FOR RADIOACTIVE MATERIALS

Overview

At times a department may find it necessary to order radioactive materials. Due to the sensitive nature of these orders, additional approval processes must be granted before the order can be placed with the supplier.

Upon departmental approval, the requisition will update to a Pre-approved status and will be automatically routed to Radiation Safety for secondary approval. Please note; the order will not be placed until the requisition is ultimately approved by a Radiation Safety staff member. Upon the approval of Radiation Safety, the requisition will be autocreated into an order and placed with the supplier. When submitting requisitions for radioactive materials, please be sure to allow for ample time to accommodate the approval process, especially in cases where the materials are needed quickly (rush orders).
Entering a Radioactive Materials Order – Differences from Basic Requisition

When creating a Purchase Order for radioactive materials, the instructions provided for entering a basic requisition can be followed with the following exceptions:

1. **Order Type field** – Due to the additional authorization needed, all radioactive material orders must be done as a PO-Doc or a PO-No Doc.

2. **Location** field – All radioactive materials must be received by Radiation Safety, therefore, select a location code that specifies that the order be shipped to the attention of Radiation Safety. Departments that purchase these types of materials should ensure that at least one of their ship-to location is designated for the Radiation Safety Office.

Select a location which specifies shipment to the Radiation Safety office

Select PO-Doc or PO-No Doc
3. **Description (line)** field – The description must include the radioactive isotope being ordered as well as the appropriate catalog number.

![Image of description field]

3. Enter a description that includes a catalog number and the radioactive isotope.

4. **Quantity** field – Enter the number of micro or millicurries required.

5. **Distribution** – The natural account used for all radioactive orders must be **601700**.

![Image of distribution field]

5. Enter **601700** for all radioactive orders.

After a department approves a requisition, it will update to the Pre-approved status. This indicates that the requisition is still pending approval from Radiation Safety.
Upon approval by Radiation Safety the requisition status will update to Approved.

Once the requisition is approved by Radiation Safety, it will be received in Purchasing at which time it will again be reviewed for accuracy, completeness and policy compliance. If there are problems, the requisition will be returned to the preparer. In the event the requisition is returned, the preparer can then make the necessary changes to the requisition. Once the changes have been made, the requisition will then need to be resubmitted for department approval as well as Radiation Safety approval. Refer to the Returned Requisitions section for additional information relative to returned requisitions.
CREATING A CHECK REQUEST

Overview

In some cases, based on the expenditure, a Check Request may be more appropriate than a Purchase Order. To enter a Check Request, create a basic requisition. Upon approval, the requisition will then be autocreated into an order. An “official” Purchase Order, however, is not produced, only a check.

The most common uses for Check Requests include:

- Travel reimbursements
- Dues and subscriptions
- Travel registrations
- Honorariums
- Research stipends
Entering a Check Request – Differences from Basic Requisition

When creating a check request, the instructions provided for entering a basic requisition can be followed with the following exceptions:

1. The **Order Type** (found on the line item section of the requisition) will be one of the following:
   - **CkReq-Doc** - Check Request with documentation
   - **Ck Req-NoDoc** - Check Request without documentation.

2. The **Location** field for a check request refers to where the check will be sent. There are two options:
   - In most cases, it is best if the check is sent directly to the supplier as it has been defined. For this option, enter *SUPPLIER* in the Location field.
   - On occasion, it may be necessary to send the check back to the department. This option should be exercised as an exception only when it is necessary due to large/bulky enclosures that must be included or in cases where a check is given as part of a presentation. In this case, the check will be sent to the department designee only. The department designee code is indicated by the *** at the end of the buyer code. For example, for Pediatrics (PD), the department designee code is PD***.

3. When entering the supplier information, this refers to the individual or organization to whom the check will be payable. Select the correct **Supplier** name and address (Site).
4. A clear description, including the business purpose, is required for all check requests. There is a large amount of space available within the line description to allow for adequate detail. In addition, the Trailer Comments fields (text) can be used to provide additional detail.
REQUISITION APPROVAL

OVERVIEW

To submit the requisition for approval, the preparer will access the Approve Document window by selecting the Approve button from the bottom of the Requisitions window.

Each department has defined a Requisition Approval Hierarchy. This hierarchy dictates where a requisition will automatically be routed when the Submit for Approval process is initiated. This routing is done using Oracle workflow. When the preparer has completed the requisition, it is submitted for approval. A notification will be sent to the first approver in the department hierarchy.

SUBMIT FOR APPROVAL PROCESS

1. Use the Approve Document window to take approval actions on documents that have been created. Navigate to the Approve Document window by selecting the Approve button from the Requisitions window.
2. The **Submit for Approval** box will automatically be checked.
3. Enter notes in the **Note** field to record information about the approval action or provide instructions to approver.
4. Select **OK**.
5. Once submitted, the requisition status will change from **Incomplete** to **In Process**. A notification will be sent to the first approver in the department hierarchy.
FORWARDING NOTIFICATIONS

If the first person in the hierarchy is going to be out of the office, the approver should notify the Security Administrator via email to rschaubb@mcw.edu. Include in the email the dates the approver will be gone and an out-of-office message for the requestors to receive. A workflow notification rule will occur and the notifications will be automatically forwarded to the next approver in the hierarchy.

- The status of the requisition will change from **Incomplete** to **In-Process** and a notification will be sent to the designated “forward to” approver.
NOTIFICATIONS

**Navigation Path:** MCW Purchasing End-User Entry > Notifications Summary.

**Overview**

Requisitions are approved through the **Notification** Page, accessible through the **Notifications** form in the Purchasing application. The **Notifications Summary** displays all of the notifications from Purchasing and ePAR including those documents awaiting the user’s approval.

The **Notification View** will default to **Open Notifications**. Access the **Notification View** drop down window to select other views.

The **Notification** displays the following information for each notification:

- **From** – Indicates the individual from whom the document was prepared or forwarded.
- **Type** – Indicates the item type with which the workflow process and notification is associated. PO Requisition Approval indicates items processed thru Purchasing while HRMS Self Service indicates items from ePARs.
- **Subject** – Displays a description of the notification.
- **Sent** – Indicates the delivery date of the notification.
- **Due** – Not currently being used.

**NOTE:** When utilizing the Purchasing responsibility, only requisitions can be. DO NOT PROCESS ePAR approvals from the Purchasing Application.

**NOTE:** Columns may be sorted by selecting any column heading.
Notifications View

By selecting a specific View in the Notifications, users can sort the notifications by categories:

1. To sort the notifications, select the the View drop-down arrow. A drop-down list will appear.

2. Select the desired view then select the Go button.

- **Open Notifications** view – In most cases, the **Open Notifications** view is preferable. All open notifications will appear including open ePARs and open requisitions. Go to the ePAR responsibility to take actions on ePAR's.

- **All Notifications** view – Shows both Open and Closed Notifications. Closed indicates that the notification of the action has been completed. It does not indicate the action has been closed. Cancelled indicates the transaction has moved to another approver and another notification will also be on the list.

- **FYI Notifications** view – Shows transactions which have been forwarded from another user. May include requests to review or more information. These actions will also appear in Open Notifications.

- **Notifications From Me** view – Displays all actions that you have reassigned requests for more information or returned. If a notification for request for more information is used, the notification will be removed from the Open Notification until the response returns. Consequently, it is important if you use the request for more information feature that this view is used frequently to assure notifications are not misplaced.

- **To Do Notifications** view – Displays notifications for which actions still need to occur. These notifications will also appear in the Open Notifications view.

To open multiple **Notifications** at one time, check the appropriate **Select** boxes and select the **Open** button. Detail for the first notification will appear. To view the next notification, select the **Continue** button.
Viewing PO Notifications

1. Navigate to the full details of any notification and act on the notification either by checking the appropriate Select box or by accessing the notification’s Subject link. The notification detail will appear.

   To open Requisitions window, select Open Document. The approver may modify the document or view or multiple project distributions from the Requisitions window.

2. From this window, the user can drill down for further information by selecting View Requisition Details.
3. To get distribution detail for a specific requisition line, select **View** from the appropriate line.
4. To select additional distribution lines to view, use the browser Return function to return to the previous window.

**NOTE:** Although multiple lines of General Ledger distribution will appear on this notification window, multiple Project accounts or combinations of Project and GL distributions will not display completely. Use the Open Document functionality (See screen below item #1 above) and view those distributions through the actual Requisition Entry window.

5. From the opened notification, the user may open the document to view and modify it as applicable. To open the document, select **Open Document**. This enables approvers to make modifications directly within the **Requisitions** window. **NOTE:** Once all appropriate changes are made to the requisition, the approver must return to the Notification Details window and to approve the document. Refer to the following section, Approving the Requisition, for further detail relative to approvals.
Approving the Requisition

Once the requisition has been reviewed, corrected as necessary and is ready for approval, the approver will approve the document by selecting the Approve button from the notifications window.

1. The notification will automatically be removed from the Open view. It can be viewed from the Notifications from Me and the All Notifications views.
2. In most cases, the status of requisition will update to Approved. A separate notification will be sent to the preparer indicating that the requisition has been approved.
3. If the requisition is for the purchase of radioactive materials, the status will now be Pre-approved pending approval by a radiation safety staff member. In these cases, a notification at this point will be sent to the radiation safety department rather than the preparer. Upon approval of the requisition by Radiation Safety, a separate notification will be sent to the preparer indicating that the requisition has been approved.
REJECTING THE REQUISITION

If the approver is not satisfied with the requisition, it can be rejected and returned to the preparer for correction or deletion. When rejecting a requisition always be sure to enter a note in the Note field explaining the reason for the rejection. Once the note is added, select the Reject button.

1. The next notification will automatically appear. Close the Notification window by selecting Return to Worklist.
2. The notification will now be removed from the Open view.
3. The status of requisition will now be Rejected.
4. A notification will be routed to the preparer indicating that the requisition has been rejected.
OTHER NOTIFICATIONS

Notifications indicating that a requisition has been Approved, Rejected or Returned is informational messages only. These messages are sent to the preparer to indicate the status of the requisition. The user can view the requisition details as outlined above or the notification may be closed.

1. Open the notification, review the details and close from within the notification window.
2. If the requisition has been rejected or returned, the preparer will need to review the information in the Note section and make all applicable changes to the requisition.
To address notifications indicating that the Document Manager has Failed, open the notification and read the detailed message. An Online Service Request may be necessary to resolve the issue. See Service Center (Help) on the Oracle Home Page (http://infoscope.mcw.edu/display/router.asp?docid=7937).

Notifications indicating Unable to Reserve, or Failed to Reserve Funds inform the user that the requisition has failed funds check. To resolve funding issues either:

1. Attempt to reserve the funds again after the account has been changed or more funds have been allocated to the account in question. To retry, open the notification and select the Try Reserving Again button.
2. Reject the requisition by selecting the Send Back to Preparer button. When rejecting requisitions always be sure include the reason for the rejection in the Note field.

NOTE: It is important to open and review the notification work list on a regular basis. Be sure to close informational messages periodically.
UPDATE/CHANGE/DELETE A REQUISITION

OVERVIEW

The requisition approver can update or change information on a requisition prior to sending it through the approval process. To update a requisition, open the document by selecting Open Document from the Notifications window. The Notifications to Requisitions window will appear. Make the necessary modifications to the document and save and close the window.

If the “clear field” functionality is used, be sure to save the record to ensure that the field is truly cleared. If the order type needs to be changed, it must be done at the header level (flexfield); all lines will automatically change accordingly.

Please note: The approver cannot approve a requisition from the Notifications to Requisitions window. If the requisition is ready to be approved, return to the notifications window and approve it from there.

Instead of approving a requisition, the approver can reject the requisition and send a note to the preparer to make specific changes. Alternatively, the approver can make the changes directly to the requisition without rejecting it.

NOTE: Once the requisition is approved, the information cannot be changed. Contact the Purchasing Department (for Purchase Orders/Standing Orders) or the Accounts Payable Department (for Checks Requests), if information needs to be changed after approval.

While the requisition is in the Incomplete status, the department also has the ability to delete it. If the delete function is performed, however, there is no record of that transaction. Instead of deleting, contact the Purchasing or Accounts Payable Department and the line will be cancelled.
REQUISITION STATUS

OVERVIEW

The status of the requisition plays an important role in terms of where the requisition can be viewed and what further actions can be performed.

Here is a summary of the various requisition statuses:

- **Incomplete** – the requisition is incomplete, or the preparer has not yet submitted the requisition for approval.

- **Rejected** – the approver rejected the requisition.

- **Returned** – Purchasing or Accounts Payable returned the requisition to the preparer.

- **In-Process** – the requisition has been submitted for approval but not yet approved.

- **Approved** – the requisition has been approved by the department approver.

- **Pre-approved** – In most cases, this status indicates the requisition cannot be approved because it failed the funds check. If the requisition is for the purchase of radioactive materials however, the Pre-approved status indicates that the requisition has been approved by the department approver and is pending approval by the radiation safety office.

Requisitions that are Incomplete, Rejected, or Returned can be viewed and modified in either the Requisitions window or the Requisition Summary window.

Requisitions that are In-Process, Approved or Pre-approved can only be viewed in the Requisition Summary window. See subsequent section on *Inquiry on a Requisition* for more information.
ORDER PROCESSING

OVERVIEW

A job will run regularly throughout the day, which will produce a processing copy of the requisition once it is approved. For requisitions with order types of Purchase Order and Standing Order, the processing copy will be printed in the Purchasing Department. For requisitions with the order type of Check Request, the copy will be printed in the Accounts Payable Department.

Both Purchasing and Accounts Payable will review the requisitions for accuracy, completeness, compliance to policy, etc. If there is a problem with the requisition, the requisition will be electronically “returned”. See additional information on “Returned Requisitions” below.

If the requisition is acceptable, an autocreate process will take place. In Oracle, the autocreate process creates the order. The order will be given the same number as the requisition. It is important to remember that Oracle will always refer to the order as a “Purchase Order”. This Purchase Order terminology includes all MCW order types – Purchase Order, Standing Order and Check Request. For MCW Reports, they will be referred to as “Orders”.

Here is a summary:

<table>
<thead>
<tr>
<th>ORACLE NAME:</th>
<th>REQUISITION</th>
<th>PURCHASE ORDER</th>
</tr>
</thead>
<tbody>
<tr>
<td>MCW REPORTS:</td>
<td>REQUISITION</td>
<td>ORDER</td>
</tr>
<tr>
<td>Order Type:</td>
<td>Purchase Order</td>
<td>Order Type:</td>
</tr>
<tr>
<td></td>
<td>Standing Order</td>
<td>Purchase Order</td>
</tr>
<tr>
<td></td>
<td>Check Request</td>
<td>Standing Order</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Check Request</td>
</tr>
</tbody>
</table>

For Purchase Orders and Standing Orders, the Purchasing Department will perform the autocreate process. Any changes that need to be made to correct pricing, availability, or product information will be done on the order. Once complete, Purchasing will approve the order. At this time, the “Official Purchase Order” will be mailed or faxed to the supplier. If the order is a Confirming Order, it is imperative that it is noted in the trailer comments as such. The “Official Purchase Order” will then be marked as confirming which should eliminate the potential for a duplicate shipment.

For Check Requests, Accounts Payable will perform the autocreate process. Provided that the order is accurate, complete, and in compliance with MCW policies, the order will be approved, an invoice will be created, and payment will be scheduled.
RETURNED REQUISITIONS

When requisitions are received in Purchasing or Accounts Payable, they will be reviewed for accuracy, completeness and policy compliance. If there are problems, the requisition will be returned to the preparer. Some examples of reasons for returning the requisition may include:

- Documentation is missing.
- The business purpose is not adequate.
- The requisition was made out for the incorrect amount (example wrong mileage reimbursement rate was used, sales tax was included over $1.00, expenditures were over the per person limit).

The notification that the preparer will receive will look like this:

![Notification Example]
Upon opening the notification (selecting the **Subject** link), a message will appear describing why the requisition was returned.

The preparer can then make the necessary changes to the requisition or submit the additional documentation that is needed. Once the changes have been made, the requisition will then need to be resubmitted for department approval. *See previous section on Approving the Requisition/Other Notifications.*
Oracle maintains an audit trail of approval activity. The activity can be displayed by inquiring on the requisition using the **Requisition Summary** window. Select **Tools > View Action History** from the toolbar menu to open the **Purchase Requisition** window that displays action history for the current line.
FUNDS CONTROL IN PURCHASING & ACCOUNTS PAYABLE

FUNDS CHECK

Overview

In the Purchasing and Accounts Payable applications, the system performs a “funds check” to ensure that adequate funds are available for specific transactions at the following times:

- Requisition Approval
- Order Approval
- Invoice Validation

The following equation always holds true:

Funds Available = Budget – Actual Expenditures – Encumbrances.

In the event that sufficient funds are NOT available, the transaction is stopped and cannot be processed any further. The requisition or order approvals cannot take place and the invoice cannot be paid.

The system does allow for requisition preparers to check funds prior to submitting for approval. This is covered in the previous section on Creating New Requisitions under Check Funds.

If the requisition failed or partially failed funds check, there are two options:

- Contact the Budget Department and initiate the appropriate changes so that adequate funds are available. Repeat the check funds process to ensure that adequate funds are now available. If the requisition has already been submitted for approval, through the notifications window, select Try Reserving Again.

- Change the account number. If the status of the requisition is Incomplete, make any necessary changes and then check funds again. If the requisition has already been submitted for approval, through the notifications window, select Try Reserving Again.
ENCUMBRANCE ACCOUNTING

Encumbrance accounting is a very useful budgetary tool, which prevents overspending on a budget and helps predict cash outflow. Encumbrances are created to reserve funds against the budgets that are defined in General Ledger and/or Project Accounting. The encumbrances are created as follows:

- **When the requisition is approved:**
  - A Requisition Encumbrance is created

- **When the order is approved:**
  - The Requisition Encumbrance is relieved
  - A Purchasing Encumbrance is created

- **When the invoice is validated:**
  - The Purchasing Encumbrance is reversed.
  - An Invoice Encumbrance is created

- **When the invoice is posted (accounting created):**
  - The Invoice Encumbrance is reversed
  - The actual expenditure is created

More detail can be found on this process, including how the encumbrances look, in the General Ledger and Project Accounting User Chapters.
INQUIRING ON A REQUISITION

**Navigation Path:**  MCW Purchasing End-User Inquiry or MCW Purchasing End-User Entry > Requisitions > Requisition Summary

To locate requisitions, select **Requisitions > Requisition Summary** from the MCW Purchasing End-User Inquiry or MCW Purchasing End-User Entry menu. The Find Requisitions window will appear.

This window will help specify the search criteria to identify the requisition(s) needed. Query on any fields that have a white background. Multiple fields can be selected to restrict the search. The results displayed will be based upon the VPD security of requestor. Requisition inquiries can be performed at three levels:

- Headers
- Lines
- Distributions

![Find Requisitions Window](image-url)
Querying by a **Requisition Number**, if known, is the most frequent inquiry. **Always use a limited query.** To query on a partial string, use the wildcards: `%___%`. Click the **Requisition Number-LOV** to find a specific requisition.

The **Preparer** is the individual initiating the requisition.

Querying by **Buyer** is not applicable.

The **Requestor** is the individual requesting the item/service to be purchased.

**Line Type** allows you to search by Purchase Order, Standing Order, or Check Request.

Select one of the three results to determine which form will be populated. The details of each form are listed on the following pages:

- **Headers**: Summary of the order.
- **Lines**: Detail of the order.
- **Distributions**: The account from which the item was billed.

**NOTE**: These forms can be located by selecting the buttons at the bottom of the "Find Requisition" form.

Entering information in the other tabbed regions will further restrict the search. Listed below are some examples.
STATUS TAB

In the Status region, the search can be limited to an Approval status (Approved, Incomplete, In Process, Pre-Approved, Rejected, or Returned) or Control status (Open, Cancelled, or Finally Closed).
DATE RANGES TAB

In the **Date Ranges** region, ranges can be entered for the following: **Creation** dates, **Need By** dates, and/or **Closed** dates. Please note: when using the date range functionality it is important to populate the fields using the calendar option. To access the calendar, select the **LOV**.
SOURCING TAB

In the **Sourcing** region, the search can be restricted by Source (Supplier or Inventory). Since MCW requisitions will always be sourced by suppliers, select **Supplier** from the **Source** field. Populate the **Supplier** field with the desired supplier name.

![Find Requisitions (Medical College of Wisconsin)](image)

Select **Supplier**

Enter the desired supplier name

**Source**
- **Supplier**
- **Site**
- **Currency**
- **Organization**
- **Subinventory**

**Type**
- **Requester**
- **Modified**
- **Import Source**

**Line Type**
- **Register**
- **Lines**
- **Distributions**

**Clear**
**New**
**Find (E)**
DELIVER TO TAB

To view requisitions for a particular ship-to location, use the Delivery To tab and enter the applicable information in the Location field.

Enter the Ship-to code in the Location field.
ACCOUNTING TAB

In the Accounting region, Period, GL Date, Charge Account and/or Budget Account can limit the search, and whether there are Active Encumbrances (Yes/No).

Enter the cost center to query all requisitions billed to a particular account.

Note: Once the cost center is entered, the remaining account string (natural account, fund and activity code) will be required to complete the query.
PROJECTS TAB

In the Projects region, the Project or Task number can limit the search.

Enter the Project number, or select the LOV to find the project number.
RESULTS GROUP

Select one of the choices in the Results section (Headers, Lines, or Distributions) to determine which summary window to open. Depending upon the search criteria specified all summary windows may not be available. For example, if criteria are specified in the Accounting region, only the Distributions Results will be available.

Once the search criteria are entered, select the Find button. The results will be displayed as follows:
The Approval Status field indicates the status of the requisition:

a) **Incomplete** – the requisition has been submitted for approval.
b) **Approved** – the requisition has been approved.
c) **In Process** – the requisition has been submitted for approval but is not yet approved.
d) **Pre-approved** – the requisition either failed the funds check or is pending approval from Radiation Safety.
e) **Rejected** – the requisition has been rejected by the approver.
f) **Returned** – the approver returned the requisition to the preparer.
**LINES SUMMARY WINDOW**

The Requisitions Lines Summary window displays detail for each line of the requisition queried.

**DISTRIBUTION SUMMARY WINDOW**

If distribution information is desired for a line item, select the `Distributions` button from the bottom of the Requisition Lines Summary window. A Requisition Distribution Summary window will appear.
A preparer’s name can be queried to list all requisitions created by a specific person. To query by preparer, enter the preparer’s name in the Preparer field on the Find Requisitions window. Select the Find button to execute the search.

The Requisition Headers Summary window will appear. Scroll through the list to find a specific requisition.
In addition to using the Find Requisitions window to access information, a blind query can also be performed directly from the summary windows (See Navigation Section for further information on queries).

From the **Header, Line or Distributions Summary** window, select **F11** to change the window to query mode. Fields that can be queried will turn blue.

Enter the selection criteria.

Press **Ctrl +F11** to execute the query and the results will be displayed.
Select **Ctrl + F11** to execute query and view the search results.
INQUIRY ON AN ORDER

**Navigation Path:**  MCW Purchasing End-User Inquiry or MCW Purchasing End-User Entry > Purchase Orders > Purchase Order Summary

To locate orders, select Purchase Order Summary from the MCW Purchasing End-User Inquiry or MCW Purchasing End-User Entry menu. The Find Purchase Orders window will appear.

This window will help specify the search criteria to identify the order(s) needed. The functionality of this window works very much like that of the Find Requisitions window, which is described fully in the previous section on Inquiry on a Requisition.

**NOTE:** It is important to note that the path to get to distributions is different on orders than on requisitions:

Requisition Summary > Find Requisitions > Lines > Distributions

Purchase Order Summary > Find Purchase Orders > Lines > Shipments > Distributions
Entering information in the other tabbed regions will further restrict the search. Once the search criteria are entered, select the **Find** button. The appropriate window will appear based upon selection made from the **Results** options.
**VIEWING ACTION HISTORY**

**Navigation Path:** View Action History from the toolbar in the following windows

Accessing the action history allows the user to view the status of any requisition or order. Action history can be viewed from any of the following windows.

- Purchase Orders
- Purchase Order Shipments
- Purchase Order Distributions
- Purchase Order Headers Summary
- Purchase Order Lines Summary
- Purchase Order Shipments Summary
- Purchase Order Distributions Summary
- Requisition Headers Summary
- Requisition Lines Summary
- Requisition Distributions Summary

To view action history from the **Requisitions Summary** window, select **Tools > View Action History**. To view action history from the **Purchase Orders Summary** window, select **Inquire > View Action History**. Once selected, the action history will display multiple pieces of information.
Purchasing  Viewing Action History

- **Seq** field – Sequence in which each action took place
- **Date** field – The date on which the action took place
- **Rev** field – Indicates the revision number
- **Action** field – Indicates the action performed (Accept, Approve, Approve and Reserve, Cancel, Forward, Import, Reject, Reserve, or Submit)
- **Performed By** field – Displays the name of the individual who initiated the action
- **Notes** field – Displays any notes

The action history window displays only those actions that occurred at the document header or that affected the header. For example, if a line was changed, which incremented the document Revision number in the header, the action history window displays the new document Revision number, not the resulting line-level.

When the **Action** field is empty, the **Performed By** field displays the name of the employee in whose approval queue the document currently resides.
PURCHASING REPORTS

OVERVIEW

Reports have been developed that allow end-users to print a hardcopy of individual requisitions and orders at any point in time. Additionally, reports are available that provide lists of requisitions and orders at certain statuses.

Since all reports, programs, and request sets are run as concurrent requests in Oracle Applications, use the Requests window to view the status and output of specific requests.

The Requests window is used to view a list of all submitted concurrent requests, check whether the request has run, change aspects of a request’s processing options, or diagnose errors.

Details on most commonly used reports are discussed in this section.
NAVIGATION TO REQUEST REPORTS

The following is a brief review of how to use the Find Requests window. Complete details regarding Requests (Reports) can be found in the Navigation section.

The Requests window can be accessed in two ways. Navigate to the window by selecting View > Requests from the toolbar. Requests are also an item found within the Purchasing Navigator window.

1. Select View > Requests from the toolbar. The Find Requests window will appear.
2. Select the Submit a New Request button. The Submit a New Request window will appear.
3. Select the Single Request option, select OK. The Submit Request window will appear.
4. From the Name field, enter the name of the desired report (request) or select the LOV to view the list of available reports.
7. Once a report is selected, the Parameters window, specific to that report, will appear. Enter the specific parameters then select OK. The Submit Request window will reappear.

8. Select the Submit button. The Requests window will appear.

9. Monitor the request from the Requests window. Please note, this window is static therefore the information will need to be refreshed to view the current status. To refresh the window, select the Refresh Data button. Continue this process until the request phase is Complete.

10. Select the View Output button to view the results of the request.

11. If desired, print the report.
MCW REQUISITIONS - PRINT END USER COPY REPORT

This report displays the details of a specific requisition. This report can be run at any time, and will reflect the status of the requisition at that point-in-time. Only requisitions for which the requestor has access, via VPD security, can be viewed.

Report Parameters:

1. Enter the desired Requisition number(s). Up to eight requisitions may be selected. If necessary, select the LOV to view all the requisitions that the end-user has security to view. Select the desired requisition(s). Select OK.

2. Select the Submit button.

3. Select the Refresh Data button until the report completes.

4. Select the View Output button.

The following report will appear.

<table>
<thead>
<tr>
<th>Line</th>
<th>Order Type</th>
<th>Item Description</th>
<th>Quantity</th>
<th>TN</th>
<th>Unit Price</th>
<th>Extended Price</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>PO-ReqDoc</td>
<td>AVER11215 12 Tab Index Dividers</td>
<td>1</td>
<td>Each</td>
<td>$6.14</td>
<td>$6.14</td>
</tr>
<tr>
<td>2</td>
<td>PO-ReqDoc</td>
<td>AVER11206E 2&quot; 3-Ring Binder</td>
<td>1</td>
<td>Each</td>
<td>$11.72</td>
<td>$11.72</td>
</tr>
</tbody>
</table>

Note: Business Associates: Business Assoc. Agreement Not Needed

MCW Requisitions - Print End - User Copy
PO-ReqDoc

Supp. Code: PD
Supplier Name: Hatfield, Rebecca M
Ship To: PO001
Order Status: RETURNED

Attn: Rebecca Hatfield 14048
Milwaukee WI 53226
US

Date: 04/23/2008
Page: 1 of 1
MCW REQUISITIONS – LIST OF UNAPPROVED REPORT

This report lists all of the requisitions that have been entered but are not yet approved. The results displayed will be based upon the VPD security of requestor. This report can be run by specific or all order types. The report output will be categorized by each status; for example, Incomplete, Pre-approved, Rejected or Returned will all be listed separately. This list will be helpful for the approver to identify those requisitions that need approval or are pending and need follow-up.

Report Parameters:

1. Select the appropriate Order Type
   - All – All order types
   - Check Requests – Check requests with or without doc
   - Purchase Orders – Purchase orders with or without doc
   - Standing Orders – Standing orders with or without doc

2. The Buyer Code field is optional. If left blank, the report will display all of the requestor's requisitions available within their VPD security. Select OK.

3. Select the Submit button.

4. Select the Refresh Data button until the report completes.

5. Select the View Output button.

The following report will appear.

<table>
<thead>
<tr>
<th>Req. No</th>
<th>Req. Date</th>
<th>Order Type</th>
<th>Supplier</th>
<th>Total</th>
<th>Buyer Designee</th>
</tr>
</thead>
<tbody>
<tr>
<td>651589</td>
<td>05-JAN-04</td>
<td>Check-DisDoc</td>
<td>AP SOC OF HEMATOLOGY</td>
<td>$195.00</td>
<td>Rebecca Barton/656-4200</td>
</tr>
<tr>
<td>652477</td>
<td>07-JAN-04</td>
<td>Check-DisDoc</td>
<td>INVECTIDOS CORPORATION</td>
<td>$93.45</td>
<td>Rebecca Barton/656-4200</td>
</tr>
<tr>
<td>653166</td>
<td>16-JAN-04</td>
<td>Check-DisDoc</td>
<td>UTILITIES STAFFING</td>
<td>$384.00</td>
<td>Rebecca Barton/656-4200</td>
</tr>
<tr>
<td>653205</td>
<td>05-FEB-04</td>
<td>Check-DisDoc</td>
<td>OZARK SODIUM</td>
<td>$204.00</td>
<td>Rebecca Barton/656-4200</td>
</tr>
<tr>
<td>661084</td>
<td>09-FEB-04</td>
<td>Check-DisDoc</td>
<td>D &amp; R FOOD SERVICES INC</td>
<td>$44.00</td>
<td>Rebecca Barton/656-4200</td>
</tr>
<tr>
<td>661188</td>
<td>11-FEB-04</td>
<td>Check-DisDoc</td>
<td>AVANCE OF PEDIATRICS</td>
<td>$199.00</td>
<td>Rebecca Barton/656-4200</td>
</tr>
<tr>
<td>661440</td>
<td>12-FEB-04</td>
<td>Check-DisDoc</td>
<td><strong>NEW SUPPLIER</strong></td>
<td>$1,490.00</td>
<td>Rebecca Barton/656-4200</td>
</tr>
<tr>
<td>661447</td>
<td>12-FEB-04</td>
<td>Check-DisDoc</td>
<td><strong>NEW SUPPLIER</strong></td>
<td>$1,844.40</td>
<td>Rebecca Barton/656-4200</td>
</tr>
<tr>
<td>662062</td>
<td>15-FEB-04</td>
<td>Check-DisDoc</td>
<td>MILWAUKEE COUNTY EMERGENCY MEDICAL SERVICES</td>
<td>$155.00</td>
<td>Rebecca Barton/656-4200</td>
</tr>
<tr>
<td>662657</td>
<td>24-FEB-04</td>
<td>Check-DisDoc</td>
<td><strong>NEW SUPPLIER</strong></td>
<td>$3,268.21</td>
<td>Rebecca Barton/656-4200</td>
</tr>
<tr>
<td>662966</td>
<td>27-FEB-04</td>
<td>Check-DisDoc</td>
<td><strong>NEW SUPPLIER</strong></td>
<td>$109.00</td>
<td>Rebecca Barton/656-4200</td>
</tr>
<tr>
<td>662967</td>
<td>01-MAR-04</td>
<td>Check-DisDoc</td>
<td>JOHNSON, ERVIN D</td>
<td>$1,757.22</td>
<td>Rebecca Barton/656-4200</td>
</tr>
<tr>
<td>667024</td>
<td>09-MAR-04</td>
<td>Check-DisDoc</td>
<td>ELMOW CENTER OF SE WI INC</td>
<td>$8.00</td>
<td>Rebecca Barton/656-4200</td>
</tr>
</tbody>
</table>
MCW REQUISITIONS – LIST OF OPEN REQUISITIONS REPORT

This report provides a list of all open requisitions. Open requisitions include those with a status of Incomplete, In Process, Pre-approved, Returned, Rejected and Approved but not autocreated. Output will include only those requisitions for which the requestor has VPD access.

Report Parameters

1. Select the appropriate Order Type
   - All – All order types
   - Check Requests – Check requests with or without doc
   - Purchase Orders – Purchase orders with or without doc
   - Standing Orders – Standing orders with or without doc

2. The Status field is optional. If left blank, the report will default to All resulting in the display all of the statuses. Select OK.

3. Select the Submit button.

4. Select the Refresh Data button until the report completes.

5. Select the View Output button.

The following report will appear.
MCW ORDERS – PRINT END-USER COPY REPORT

This report displays all details of a specific order. Only orders for which the requestor has access, via their VPD security, can be viewed. This report can be run at any time and reflects the status of the order at that point-in-time. Do not confuse this report with the “Official Purchase Order” that can only be printed by the Purchasing Department. This report is provided for end-user convenience so that a hard-copy of the order can be maintained in their department.

Report Parameters

1. Enter the desired Order number(s). Up to eight orders may be selected. If necessary, select the LOV to view all the orders that the end-user has security to view. Select the desired requisition(s). Select OK.
2. Select the Submit button.
3. Select the Refresh Data button until the report completes.
4. Select the View Output button.

The following report will appear.
MCW ORDERS – LIST OF OPEN ORDERS REPORT

This report lists all of the orders based upon the parameters chosen and the VPD security of the requestor. An open order is defined as an order that has not been fully paid. An order is fully paid when the quantity (not the price) has been reduced to zero.

This report can be run to show open standing orders so that the list can be reviewed to ensure there are adequate dollars in all standing orders.

Report Parameters

1. Enter the desired Order Number. This field may be left blank to display all open orders based on the remaining criteria.

2. Enter the desired Supplier. This field may be left blank to display all open orders based on the remaining criteria.

3. Enter the desired Buyer Code. This field may be left blank to display all open orders based on the remaining criteria.

4. Enter the desired cost center range in the Cost Center From and Cost Center To fields. These fields may be left blank to display all open orders based on the remaining criteria.

5. Enter the desired Project Number. This field may be left blank to display all open orders based on the remaining criteria.

6. Select the desired Order Type. This field may be left blank to display all open orders based on the remaining criteria.

7. Enter the desired department number range in the Department From and Department To fields. These fields may be left blank to display all open orders based on the remaining criteria.

8. Select OK.

9. Select the Submit button.

10. Select the Refresh Data button until the report completes.

11. Select the View Output button.

The following report will appear.
FREQUENTLY ASKED QUESTIONS

➢ What if the supplier I need to use for my requisition is not in the list of suppliers in Oracle?

You can request that a new supplier be set up by performing the following:

- On the requisition line for the supplier, enter ***New Supplier***. (For more details, see Chapter 5, pages 10-11.)
- From the toolbar, select View > Zoom. The New Supplier Information window will appear which will allow you to enter the information needed for the supplier set-up.
- Be sure to supply as much information as possible.

➢ I am having difficulty when I enter requisition distribution and I try to change/delete/clear the information I entered?

A line of distribution may be deleted after it is entered provided that the requisition has not yet been submitted for approval. From the appropriate line, select the Delete icon from the toolbar. Once the line is deleted, remember to save the record. NOTE: If the record is not saved, it will appear as though the line is deleted when it is only removed from view. When the record is retrieved, the line will return.

As you are entering the distribution if you wish to clear that line, choose the Clear icon from the toolbar. Again, be sure to SAVE the record. If the record is not saved, it will appear as though the line is cleared when it is only removed from view.

If you are not sure what has been deleted or cleared, it is best to close the record completely then re-query to view the information.

➢ What should I do if the funds check or the approval fails due to insufficient funds?

You can change the distribution to an appropriate account that has sufficient funds or you should contact the Budget Office to make the appropriate budget adjustments.
What if I need to add more than five lines to a requisition in Oracle – it only displays five lines?

Oracle allows for many lines, however, only five lines can be displayed at a time. If more than five lines are needed, more may be obtained by selecting the down arrow key. When viewing multiple lines, use the scroll bar on the side to see additional lines.

What if I need to see the entire description for a line - Oracle only displays a limited amount of information?

From the toolbar, select the Edit Field (pencil tip) icon. Place your cursor on the field you wish to view, and then select the Edit Field icon. A window will appear which will display the entire field. It is important to note this same feature can be used when entering the line description as well – it makes entry much easier as all the information is more visible.